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Lesson Objectives 

 To discuss decisions that must be made before using QuickBooks 

 To create a new QuickBooks company using the EasyStep Interview 

 To set QuickBooks preferences in the Interview 

 To record the opening balance for a checking account 

 To enter customers, jobs, vendors, accounts and items for a QuickBooks company 
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Creating a QuickBooks Company 

A QuickBooks company contains all the financial records for a single business. Before you can use QuickBooks you 
need to tell QuickBooks about your business so that it can set up your company file properly.  

 Express Start will set up a new company file for you based on some standard industry settings. (Any fine tuning 
of the company file can be done later.) 

 Detailed Start opens the EasyStep Interview and will give you more control over the fine tuning of your company 
file as you set it up. 

 Your other options are to create a file by copying list data from an existing file, or by converting data from another 
accounting system. 

In the Detailed Start option (option #2 above) you will set up the following using the EasyStep Interview: 

 Company Information 

 Chart of Accounts based on your industry 

 Company organization 

 Sales information 

 Sales tax information 

 Estimates 

 Sales receipts 

 Preferences 

 Business start date 

 Creating an account and entering the opening balance 

 Reviewing the Chart of Accounts 

 Completing company file setup 

 NOTES 
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Starting the EasyStep Interview 

 To begin adding a new company: 

 Start QuickBooks. 

 Click the Create a new company file button from the No Company Open window or choose New Company from 
the File menu. 

 Click on the Detailed Start button to start the EasyStep Interview. 

 

QuickBooks displays the EasyStep Interview window. 

 NOTES
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Entering Company Information 

 To create a new QuickBooks company file: 

 At the first Welcome window for the EasyStep interview the Enter Your Company Information window appears. 

 Enter the business name in the Company Name field and press Tab. 

When you press Tab QuickBooks automatically enters the same name you typed into the Legal Name field. 
QuickBooks uses the company name on all reports. 

 Press Tab again and enter the EIN or SSN in Tax ID field.  

 Complete the remaining contact information for the company, as QuickBooks will pull this information on to sales 
forms and tax reports when you begin working in the file. 

Your screen should resemble the following. 

 

 Click Next. 

 NOTES 
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Choosing your Company Industry 

 To choose your company industry to create a Chart of Accounts: 

 Choose your industry from the list to help QuickBooks compile a suggested Chart of Accounts for your business. 

 

 Click Next. 

 NOTES
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Selecting how Your Company is Organized 

 To select your company organization:  

 Choose the company’s entity type. This will allow QuickBooks to create a suggested tax mapping for your Chart 
of Accounts. 

 Click Next.  

 Enter the beginning month of the businesses fiscal year (most commonly January), and click Next. 

 In the Set up your administrator password window click Next. (You can set the password at any time.) 

 Click Next to save the company file. 

 Name your company file (it ends in .QBW and choose the location on your computer where you wish to save it. 

 Click Save. 

 NOTES
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Customizing QuickBooks for Your Business 

After you’ve saved the company data file, the customization section of the EasyStep Interview appears. It is the place 
where you indicate: 

 What you sell 

 How and when your customers pay you 

 How you pay your bills 

Based on your answers QuickBooks sets preferences for the company file. The preferences enable certain features 
of the QuickBooks program. 

 

Click Next. 

 NOTES
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Indicating What You Sell 

You need to indicate what your business sells. In general, businesses either sell products, services or both. Margaret 
Lockhart provides consulting services as well as selling products, such as fabrics. 

 To indicate what you sell: 

 Click Next to move to the What do you sell? window. 

 Choose the appropriate option for the business. 

 

 Click Next. 

 NOTES
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Entering Sales Information 

For retail companies you need to indicate how you want to enter sales. QuickBooks uses this information to set 
recommendations for a retail-type business.  

 To indicate how you enter sales: 

 In the How will you enter your sales in QuickBooks? window choose the option that best fits the business’s 
needs. 

 

 Click Next. 

 NOTES
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Entering Sales Tax Information 

This part of the EasyStep Interview asks whether you charge sales tax. You should turn the sales tax setting off only if 
you never charge sales tax. Sometimes it is even beneficial to turn this feature on for tracking wholesale/retail sales, 
depending on the tax reporting regulations in your state. 

 To set up QuickBooks to track sales tax: 

 Click Yes in the Do you charge sales tax? window. 

 

 Click Next. 

 NOTES
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Creating Estimates 

If you provide any type of estimate or bid — even a verbal quote — there are many reasons to use estimates in 
QuickBooks. 

 Prepare professional-looking itemized estimates, bids, quotes or proposals for your customers 

 Create an invoice from the estimate with just one click. QuickBooks then creates an invoice using information 
from your estimate 

 Create reports that compare your estimated costs and revenue against your actual costs and revenue 

 Compare your actual costs against what you estimated 

 Track which estimates are still active and easily update each estimate as you continue to negotiate with your 
customers 

 To create estimates for your business: 

 On the Do you want to create estimates in QuickBooks? window choose the option that best fits the business. 

 

 Click Next. 
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Creating Sales Orders 

Sales orders allow you to record an order for a sale before the sale is actually is made. These forms are common in 
business that order products to fill orders or that pull orders from inventory before invoicing. (Think of these forms as 
“incoming purchase orders” from customers.) These forms enable you to create partial invoices for an order if you 
have inventory items on backorder. 

 To create sales orders for your business: 

 On the Tracking customer orders in QuickBooks window choose the option that best fits the business. 

 

 

 Click Next. 
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Choosing Remaining Preferences 

The next series of windows ask Yes or No questions that either enable or disable different QuickBooks features 
based on your company needs. Simply click Yes or No, then click Next to move forward in the Interview.  

Options  Description 

Billing statements Post statement charges independently of invoices & sales receipts 

Progress invoicing Create single estimates to be invoices in phases 

Bill tracking Use the Accounts Payable module to track bills and bill payments 

Inventory Use inventory module to track inventory quantities and values 

Track time Use timecards to track employee and subcontractor time 

Employees Use payroll module to manage employee information and payroll 

 

You can always change preference settings later, after the EasyStep Interview. Changing the preferences later can be 
done by accessing the Edit menu, choosing Preferences, then selecting the preference type in the left panel. 
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Choosing a Start Date 

The Start Date is the date for which you give QuickBooks a financial snapshot of your company assets and liabilities 
before you start entering live transactions in QuickBooks. It is generally the last day of the previous fiscal period. 

 To choose a start date: 

 On the Using Accounts in QuickBooks window click Next. 

 Choose the option that best suits the business setup. 

 

 Click Next. 

 NOTES
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Reviewing the Chart of Accounts 

The Chart of Accounts is made up of five types of accounts common to all businesses — the income and expense 
accounts used by the Profit and Loss Statement, and the asset, liability and equity accounts used by the Balance 
Sheet. Each time you enter a transaction QuickBooks will prompt you to categorize it into one of these five types of 
accounts. 

Because you chose an industry from the list earlier in the Interview, QuickBooks has already created income and 
expense accounts for your company based on that choice.  

 To review the chart of accounts: 

 In the Review income and expense accounts window scroll through the preset accounts to get an idea of what is 
included. Modify the selections according to your business needs by adding or removing checkmarks. 

 

 Click Next. 

Congratulations! You have completed the Easy Step Interview.  



Lesson 2 — Setting Up Reviewing the Chart of Accounts 

QuickBooks 2015 Student Guide 20 

 Click Go to Setup. 

The QuickBooks Setup screen appears. 

 

After you have completed the EasyStep Interview use the information in the Help options described later in this 
document to help you make changes and adjustments to your company file. 

 NOTES
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Entering Bank Accounts and Opening Balances 

The balance sheet accounts in the QuickBooks Chart of Accounts start with an opening balance of zero. Before you 
begin working in QuickBooks you need to enter an opening balance for each balance sheet account as of your Start 
Date. 

 To enter bank account information: 

 On the Add your bank accounts section of QuickBooks Setup screen click Add. 

 Name each bank account in the Account Name column. Be descriptive with businesses that have multiple bank 
accounts to eliminate confusion. 

 If you are using account numbers in QuickBooks (to identify the categories in the Chart of Accounts), be sure to 
enter the corresponding number in the Account Number column. Note: This is not where you enter the actual 
bank account number from the bank! 

 For Opening Balance enter the balance in the account as of the date you are beginning the file. 

 For Opening Balance Date use the date that you are using to begin the file. Note: The opening balance amount 
should reflect the balance in the opening balance date column. 
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 IMPORTANT: The above action creates an increase to your Checking account balance and an increase to your 
Opening Balance Equity account balance. 

 Click Continue. 

 In the Order Checks screen select No Thanks (or Yes, remind me later) and click Continue. 

 (If you selected Yes, remind me later, you will see a Create Alert screen regarding printing checks.) 

 Click Start Working. 

 Close the Quick Start Center. 

 NOTES
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Completing Company File Setup 

After you have created your company file using the EasyStep Interview, you can begin using QuickBooks to run your 
business.  

However, there are some additional tasks you might need do to make sure the company file is properly set up and 
that the data is complete. 

QUICKBOOKS IS BASED ON FOUR KEY LIST CONCEPTS 

 Accounts 

 Items 

 Customers & Jobs 

 Vendors 

 NOTES
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Adding Customers 

Your Customer list is the list that will display sales forms (sales orders, estimates, invoices, sales receipts) and 
Accounts Receivable.  

 To add a customer: 

 There are multiple ways to do almost anything in QuickBooks. To access the Customer Center you have four 
options: 

− Click Customers from the left hand or top icon bar (depending on your View settings) 

− Choose Customer Center from the Customers drop-down in the menu bar 

− From the Home Screen, click on the blue Customers tab in the Customers section 

− Press CTRL+J 

 Click the New Customer & Job menu button then choose New Customer. 

 In the Customer Name field enter the name of the customer as you'd like it to appear on your Customers & Jobs 
list.  

 Press Tab in the Opening Balance field to leave this field blank. 

The Opening Balance field tells you how much each customer owes you on your start date so that when you 
enter the rest of your transactions from the day after your start date to today, all balances since your start date 
will be accurate. 

It is generally recommended entering individual outstanding invoices one by one whenever possible, rather than 
entering the outstanding balance owed in the Opening Balance field. 

 Complete the customer contact information appropriately. 
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You can have and use more than one Ship To address per customer or job. Add them with the Ship To drop-
down or by clicking the + sign in the bottom right corner. 

 

 Click OK to add this customer. 

The Customer Center appears with the Customers & Jobs list along the left side.  

 IMPORTANT: The Customers & Jobs list is the same list as the Customer/Job list. It is called Customers & 
Jobs on the Customer Center and called Customer:Job on forms. It is sometimes also referred to as simply 
the Customer list. 

 NOTES
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Adding a Job 

You do not need to add jobs to the Customers & Jobs list if your company never does more than one job or project 
per customer. Jobs in QuickBooks are optional. If you often perform multiple jobs for the same customer you can use 
jobs in QuickBooks to track the activity for each job separately.  

The Customer: Job hierarchy can be customized to meet many different needs and is commonly used in 
construction. This feature enables you to use the Customer as a parent under which to group multiple jobs. (Another 
common use of jobs is for attorneys, who handle more than one matter for each client.) 

 To add a job for a customer: 

 In the Customers & Jobs list right-click on the customer name to which you would like to add a job and choose 
Add Job. 

 Name the job in the Job Name field. 

 For Opening Balances refer to the information in Adding a Customer in the previous chapter. 

 

 Click OK. 

 If you see a message about a past or future transaction click Yes to save the transaction. 

The job will now appear under the Customer (also referred to as parent) in the Customer list. 

 IMPORTANT: Notice that there are more tabs with information that you can add for Customer:Job setup. These 
features include payment information, sales rep and job status. It is important to understand your tracking 
and reporting goals to ensure that these features are set up and utilized properly. 
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Adding Vendors 

In order to pay your bills with QuickBooks you need to add your vendors (sometimes referred to as suppliers). Nearly 
everyone you pay, other than employees, is a vendor. Your vendor list supplies the names available on purchase 
forms like purchase orders, vendor credits, sales tax payments, payroll tax payments and bills. 

 To add a vendor: 

 Just like the Customer Center, there are multiple ways to access the Vendor Center in QuickBooks. 

− Click on Vendors from the left side or top icon bar (depending on your View settings) 

− Choose Vendor Center from the Vendors drop-down in the menu bar 

− From the Home Screen click on the Vendors tab in the Vendors section 

 Click the New Vendor button then choose New Vendor. 

 In the Vendor Name field enter the name of the vendor as you'd like it to appear on your Vendor list.  

 In the Opening Balance field this is treated the same as the Customer Center entries. You can enter a balance 
owed to the vendor as of the start date of the file, but it is best practice to enter individual open bills when you 
can. 

 Enter the remaining vendor information appropriately. 

 Click OK to add this vendor. 

The new vendor appears on the Vendor list. 

 

 Close the Vendor Center. 

 IMPORTANT: Notice that there are additional tabs in the vendor setup window. Feel free to utilize these 
features as they apply to your business. Pay special attention to the Tax Settings tab if you would like to run 
1099 reports from QuickBooks. 
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Setting Up Additional Accounts 

During the EasyStep Interview you added your bank accounts.  

There are two basic types of accounts: 

 Balance sheet accounts, such as savings or checking  

 Accounts used to group transactions for reporting purposes, such as income and expense accounts  

Income and expense accounts track the sources of your income and the purpose of each expense. When you record 
transactions, you usually assign the amount of the transaction to one or more income or expense accounts. 

Accounts are the core of QuickBooks. Every posting transaction (which is a transaction that affects the general 
ledger) is mapped from one account to another. For example, when you purchase paper for your office printer you 
are taking money from the bank account and recording it against an office supplies expense account. Your Chart of 
Accounts is home to all of the accounts (also referred to as categories) that show on your financial reports. 

 To add an account: 

 From the Lists menu choose Chart of Accounts (or press CTRL+A). 

 Click the Account menu button (at the bottom left of the window) and choose New (or press CTRL+N from the 
Chart Accounts window). 

 In the Add New Account window choose the appropriate account type then click Continue. 

 Click in the Account Name field and name the account appropriately. 
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 From the Tax Line Mapping drop-down list choose the appropriate mapping according to the business structure 
(or leave blank if you are unsure). 

 

 Click Save & Close. 

 NOTES
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Adding Items 

Items are what we use on sales forms like Estimates, Sales Orders, Invoices and Sales Receipts. Items show the 
products/services that are sold and each item is mapped to one or more accounts in QuickBooks. Items can be 
mapped to one, two or three accounts in QuickBooks, depending on the item setup. 

 One-Sided Items – These are items we use only on either a sale or purchase form, but not both. For example, if 
you sell consulting services. you may have an item named Consulting for use on your invoices. This item will be 
mapped to an income account for you to view on your Profit & Loss report. If this item were used on a purchase 
transaction, it would post a negative transaction to your income account. 

 Two-Sided Items – These are items we use on both a sale and a purchase form. The setup for these items 
allows you to post to an income account when used on a sales form and post to an expense account when the 
item is used on a purchase form. 

 Three-Sided Items – Three-sided items are used for inventory. The setup of these items allows you to purchase 
the item and receive it into your Inventory Asset account (part 1). When you sell the inventory the item posts to 
your Income account (part 2) and also makes a Cost of Goods Sold entry (part 3). 

In this section, we are going to look at a one-sided item entry.  
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 To add a One-Sided item: 

 From the Lists menu choose Item List. 

 

 Click the Item menu button at the bottom left of window and choose New. 
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 In the New Item window choose an item type from the Type drop-down list. 

 IMPORTANT: When you select an item type a description of how that item should be used will appear to the 
right of the drop-down box. 

 

 Assign an item name or number in the Item Name/Number field. 

 In the Description field enter the information that you would like to appear by default when this item is used on a 
form. 

 You can assign a standard per unit selling price in the Rate field.  

 In the Tax Code field assign a standard taxable or non-taxable code. 

 IMPORTANT: Items marked as Non-Taxable in the setup will not accrue sales tax on sales forms. See the 
Sales Tax training section for additional information. 

 In the Account field choose the appropriate income account to which to post when this item is used on sales 
forms. 

 Click OK to add the new item to the Item List. 

 Close the Item List.  

 NOTES
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Entering Historical Transactions 

If your QuickBooks Start Date is before today’s date, you need to enter past transactions so that you have complete 
financial records from the Start Date going forward. It is important to enter historical transactions in this order: 

 All sales (sales receipts, invoices, credit memos, or statement charges). 

 Customer payments received for outstanding invoices after the Start Date. 

 Bills and Bill Credits (also known as Vendor Credits) received since the Start Date. 

 Bills paid since the Start Date. 

 Deposits made to any of the accounts since the Start Date. 

 Any other checks written and credit card charges made (other than to pay bills), as well as bank charges and 
pre-authorized payments since the Start Date. 

 NOTES
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Setting Up QuickBooks — Review Questions 

 During the EasyStep Interview, QuickBooks creates income and expense accounts based on your company’s 

____________________  

 When setting up a company file in QuickBooks, what does the Start Date signify? 

a. The date the business was created 

b. The first date of the company’s fiscal year 

c. The date the company purchased QuickBooks 

d. The date from which you will be entering transactions in QuickBooks 

 When setting up a company file in QuickBooks at the beginning of a fiscal period, you would normally select 
which of the following as the start date? 

a. The first day of the current fiscal period 

b. The last day of the previous fiscal period 

 True or false: Once you have set up the Chart of Accounts you cannot add, delete or modify accounts. 

a. True 

b. False 

 Before working in QuickBooks you need to enter an ______________ ____________ for each account. 

 True or false: Choosing a company organization associates a tax form with your business in the QuickBooks file. 

a. True 

b. False 

 In QuickBooks, linking income and expense accounts with tax lines does which of the following? 

a. Helps keep your company profitable 

b. Helps in preparing income taxes 

c. Helps keep track of sales taxes you owe 

d. Both b and c
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Answers to Review Questions 

 During the EasyStep Interview QuickBooks creates income and expense accounts based on your company’s 
industry. 

 When setting up a company file in QuickBooks, what does the Start Date signify? 

a. The date the business was created 

b. The first date of the company’s fiscal year 

c. The date the company purchased QuickBooks 

d.  The date from which you will be entering transactions in QuickBooks 

 When setting up a company file in QuickBooks at the beginning of a fiscal period you would normally select 
which of the following as the start date? 

a. The first day of the current fiscal period 

b.  The last day of the previous fiscal period 

 True or false: Once you have set up the chart of accounts you cannot add, delete or modify accounts. 

a. True 

b.  False 

 Before working in QuickBooks you need to enter an opening balance for each account. 

 True or false: Choosing a company organization associates a tax form with your business in the QuickBooks file. 

a.  True 

b. False 

 In QuickBooks, linking income and expense accounts with tax lines does which of the following? 

a. Helps keep your company profitable 

b.  Helps in preparing income taxes 

c. Helps keep track of sales taxes you owe 

d. Both b and c 
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